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Paper Set 1 · 24 May 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A shopkeeper bought a bag for ₹1,200 and sold it for ₹1,380. Find
his profit percentage.

A.  10%

B.  12%

C.  15%

D.  18%

✓

Q2 Quant
The length and breadth of a school ground is 140 meters and 60
meters, respectively. Whereas the length and breadth of a mela
ground is 280 meters and b meters. If they are in proportion, what is
the value of b?

A.  120

B.  121

C.  122

D.  118

✓

Q3 Quant
The number 88,56,740 is divisible by:

A.  2 and 3

B.  3 and 4

C.  4 and 5

D.  5 and 6

✓

Q4 Quant
If A:B = 3:4, B:C = 5:6, C:D = 7:8 and D:E = 3:4, then find the value of
A:C:E.

A.  105:168:256

B.  256:168:105

C.  165:88:246

D.  25:41:64

✓

Q5 Quant
A boat travels 24 km downstream in 3 hours and the same distance
upstream in 6 hours. What is the speed of the stream?

A.  2 km/hr

B.  3 km/hr

C.  4 km/hr

D.  5 km/hr

✓

Q6 Quant
A solid cuboid of dimensions 36 cm × 24 cm × 18 cm is melted and
recast into solid cubes, each having an edge length of 6 cm. During
the melting and recasting process, 10% of the material is wasted.
Determine the total number of complete cubes that can be formed
from the remaining material.

A.  65

B.  64

C.  66

D.  63

✓

Q7 Quant
Aman can complete a project in 7.5 days, and Ravi can complete the
same project in 15 days. How many days will it take to finish the task
if they work together?

A.  5

B.  7

C.  10

D.  20

✓

Q8 Quant
The mean of 5 numbers is 2x (x>0). If one number is removed, the
mean becomes 1.5x. The removed number, is:

A.  x

B.  2x

C.  4x

D.  3x

✓

Q9 Quant
A, B and C started a business investing amounts of ₹710, ₹930, and
₹1,640, respectively. If B's share in the profit earned by them is
₹1,006, what is the difference in the profit (in ₹) earned by A and C?

A.  ₹1,006

B.  ₹1,009

C.  ₹1,004

D.  ₹1,003
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✓

Q10 Quant
One pipe can fill a tank in 9 minutes while another pipe can empty
the completely filled tank in 12 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill three-fourths of the tank?

A.  27

B.  54

C.  28

D.  55

✓

Q11 Quant
The profit made on a product is 63%. What is the loss percentage
(correct to two decimal place) incurred on the sale if the figures of
both cost price and selling price are interchanged?3184

A.  38.65%

B.  37.08%

C.  41.04%

D.  35.80%

✓

Q12 Quant
The difference between the compound interest (compounded
annually) and the simple interest if ₹47500 is deposited at 5% rate of
interest per annum for 2 years is:

A.  ₹118.75

B.  ₹120.50

C.  ₹111.50

D.  ₹109.75

✓

Q13 Quant
Two circles of radii 25 cm and 24 cm have the same centre. A chord
of the larger circle is a tangent of the smaller one. The length of the
chord is:

A.  7 cm

B.  14 cm

C.  48 cm

D.  50 cm

✓

Q14 Quant
In what time (in months) will ₹3000 fetch an interest of ₹400 at 10%
per year simple interest?

A.  16

B.  13

C.  14

D.  20

✓

Q15 Quant
The product of two consecutive positive integers is 812. If the
smaller of these two integers is represented by x, which of the
options below will correspond to the equation for finding out the
value of x?

A.  x2 + x - 812 = 0

B.  x2 + x + 812 = 0

C.  x2 - x - 812 = 0

D.  x2 - x + 812 = 0

✓

Q16 Quant
The ratio of income and expenditure of a person is 7 : 6. If he saves
₹25,000 per month, find his monthly income.

A.  ₹75,000

B.  ₹1,00,000

C.  ₹1,75,000

D.  ₹1,50,000

✓

Q17 Quant
A value M is first increased by 25% and then is decreased by 20%
and became ₹5,000. The value of M is:

A.  ₹5,000

B.  ₹6,250

C.  ₹6,000

D.  ₹5,825
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✓

Q18 Quant
The speed of an electric train is 25% more than that of a steam engine train. The steam engine train takes 6 hours 40 minutes to cover a certain
distance. Find the time (in hours) taken by the electric train to cover the same distance.

A.  

B.  

C.  

D.  

✓

Q19 Quant

504

A.  

B.  

C.  

D.  

✓

Q20 Quant
Which option gives the maximum value?

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
Who among the following Indians won the UzChess Cup Masters
2025 in Tashkent?

A.  Arjun Erigaisi

B.  Koneru Humpy

C.  Gukesh D

D.  Praggnanandhaa R

✓

Q22 GA
Which among the following is the first state to implement mobile-
based e-voting system as announced by the respective State
Election Commission in June 2025?

A.  Bihar

B.  Haryana

C.  Punjab

D.  Kerala

✓

Q23 GA
Which of the following is the simplest saturated hydrocarbon?

A.  Butane

B.  Methane

C.  Propane

D.  Ethane

✓

Q24 GA
"Ebony" and "Aini" tree species are the primary characteristics of
which of the following forests in India?

A.  Tropical Evergreen forests

B.  Tropical Deciduous forests

C.  Tropical Thorn forests

D.  Littoral and Swamp forests

✓

Q25 GA
Geologically, the Middle Mountainous and Highlands region of
Odisha is part of which ancient landmass?

A.  Laurasia

B.  Gondwanaland

C.  Angara

D.  Pangaea

✓

Q26 GA
The first grand meeting of Utkal Sammilani (Utkal Union
Conference) in 1903 was held at:

A.  Sambalpur

B.  Balasore

C.  Puri

D.  Cuttack

✓

Q27 GA
Under Odisha’s Viksit Odisha Vision-2036 and the Samrudha Sahar
urban scheme, planned urbanisation is targeted to reach ~40% by
which year?

A.  2030

B.  2032

C.  2036

D.  2047

✓

Q28 GA
Which of the following are considered the three main pillars of
Sustainable Development?

A.  Economy, Society, and Environment

B.  Population, Technology, and Resources

C.  Agriculture, Industry, and Services

D.  Growth, Equity, and Trade

✓

Q29 GA
The state of Odisha won the Best Stall Award at India Maritime Week
2025 held in Mumbai. What was the theme of the stall?

A.  “Odisha – Voyage of Heritage and Hope”

B.  “Blue Economy Frontier – Odisha”

C.  “Maritime Odisha: Past and Future”

D.  “Odisha – Port of Tomorrow”
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Q30 GA
The India–European Free Trade Association (EFTA) Trade and
Economic Partnership Agreement (TEPA), which came into effect on
1 October 2025, is best described as:

A.  Comprehensive free trade and investment partnership
agreement

B.  Multilateral nuclear disarmament and non-proliferation
treaty framework

C.  Regional environmental conservation and climate change
cooperation pact

D.  Bilateral defence technology sharing and intelligence
cooperation accord

✓

Q31 GA
Against which country did the Indian team chase down a record
total in the semi-final of the ICC Women’s Cricket World Cup 2025?

A.  England

B.  Australia

C.  South Africa

D.  New Zealand

✓

Q32 GA
Why are collenchyma cells suitable for supporting young plant
parts?

A.  They are flexible and can bend without breaking

B.  They are completely dead and rigid

C.  They have very thick and immovable walls

D.  They form a protective waxy layer

✓

Q33 GA
Which of the following languages is mainly related with Sangam
literature of ancient India?

A.  Tamil

B.  Pali

C.  Sanskrit

D.  Persian

✓

Q34 GA
A box rests on a table. If the box exerts a downward force of 15 N on
the table, which force acts as the reaction according to Newton's
third law?

A.  The box exerts a downward force on the ground

B.  The ground exerts an upward force of 15 N on the box

C.  The table exerts a downward force on the ground

D.  The table exerts an upward force of 15 N on the box

✓

Q35 GA
Who was the first Governor-General of India under the Charter Act
of 1833?

A.  Warren Hastings

B.  Lord Dalhousie

C.  Lord William Bentinck

D.  Lord Cornwallis

✓

Q36 GA
Which of the following was NOT a reason for the resentment among
sepoys that led to the 1857 Revolt?

A.  Low pay, poor allowances and harsh service conditions

B.  Violation of religious practices and beliefs, including the
requirement to serve overseas

C.  Connection with peasant grievances in the countryside

D.  Demand for political representation in the British
administration

✓

Q37 GA
In how many groups can the plateaus of the World be classified, on
the basis of their geographical location and structure of rocks?

A.  Two

B.  Four

C.  Five

D.  Three

✓

Q38 GA
Which classical Indian dance form was Birju Maharaj primarily
associated with?

A.  Bharatanatyam

B.  Kathak

C.  Kuchipudi

D.  Odissi
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✓

Q39 GA
According to the India State of Forest Report 2023, which of the
following states showed the maximum increase in forest and tree
cover in India?

A.  Odisha

B.  Uttar Pradesh

C.  Rajasthan

D.  Chhattisgarh

✓

Q40 GA
What does NRLM stand for in the context of rural development in
India?

A.  National Relief and Land Management

B.  National Rural Land Mission

C.  National Rural Literacy Mission

D.  National Rural Livelihoods Mission

English

✓

Q41 English
Choose the correct option to fill in the blank.

I need to buy ______ armchair and ______ sofa for my sitting room.

A.  a, a

B.  an, a

C.  a, no article needed

D.  no article needed, the

✓

Q42 English
Parts of a sentence are given below in jumbled order. Select the option in which the parts are arranged in the correct order to form a
meaningful sentence.

to / I / not / about / my / was / ability / work / worried

A.  I was not worried about my ability to work.

B.  I was worried about not my ability to work.

C.  I was worried about my ability to not work.

D.  I worried about my ability was to not work.

✓

Q43 English
What is a leader called who sways his followers by his oratory?

A.  Demagogue

B.  Dictator

C.  Debonair

D.  Dilettante
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Q44 English
Select the most appropriate idiom that can substitute the underlined segment in the given sentence.

You can’t expect overnight success; as they say, even lightning starts with clouds.

A.  fortune favors the brave

B.  success takes preparation

C.  don’t count your chickens before they hatch

D.  time waits for no one

✓

Q45 English
Select the most appropriate ANTONYM of the underlined word in the given sentence.

Though initially drafted in elliptical prose, the final version was expanded into a comprehensive, fully explicit and redundant masterwork.

A.  Oblique

B.  Ambiguous

C.  Explicit

D.  Cryptic

✓

Q46 English
For the sentence below, identify the option that is the correct antonym of the underlined word in the sentence.

They arrived at a preliminary conclusion, leaving further investigation for later.

A.  initial

B.  final

C.  tentative

D.  exploratory

✓

Q47 English
The sentence has one misspelled word (shown in italics). Choose the option with the correct spelling to replace the italicized word and correct
the sentence.

The tourists were amazed by the spectecular view of the Great Ocean Road.

A.  spectaicular

B.  spectacular

C.  spectaculer

D.  spectaculor
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Q48 English
Select the correct proverb that can substitute the underlined group of words in the given sentence.

After months of discussion and hesitation, the committee finally decided to face the difficult situation with courage and implemented the new
policy.

A.  break the ice

B.  bite the bullet

C.  hit the nail on the head

D.  burn the midnight oil

✓

Q49 English
Identify the sentence with the correct active voice usage.

A.  The committee has finally chosen the winning candidate.

B.  The manager had did the work before the deadline.

C.  The pilot flown the plane through the heavy storm.

D.  Every student in the class have finished the assignment.

✓

Q50 English
Choose the correct indirect speech form of the given sentence: The principal said, “Honesty is the foundation of good character in both
personal and professional life."

A.  The principal said that honesty was the foundation of good character in both personal and professional life.

B.  The principal said honesty had been the foundation of good character in both personal and professional life.

C.  The principal said that honesty is the foundation of good character in both personal and professional life.

D.  The principal said that honesty would be the foundation of good character in both personal and professional life.

✓

Q51 English

Read the following passage carefully and answer the questions that follow.
In 2018, a young tigress disappeared from Bandhavgarh Tiger Reserve in Madhya Pradesh. For nearly three years, she was not seen in official
records. In 2021, camera traps in Achanakmar Tiger Reserve in Chhattisgarh captured a tigress with cubs. Stripe patterns confirmed that she was
the same tigress, later named Jhumri. She had travelled nearly 400 kilometres, likely in search of new territory after reaching dispersal age. Such
movements are common when young tigers leave crowded areas to find space, food, and mates. Similar cases, like a male tiger moving from
Kanha to Achanakmar, show that forest corridors still allow movement between regions. Chhattisgarh’s tiger population, which had declined
earlier, is now increasing due to better protection, improved habitats, and stronger anti-poaching efforts. However, experts stress that
maintaining forest corridors is essential. These pathways help tigers move safely, find new territories, and reproduce, ensuring long term
survival of tiger populations in central India.

Which is the most suitable title for the passage?

A.  Life of Tigers in Zoos and Sanctuaries

B.  Tiger Movement and Forest Connectivity

C.  History of Indian Forests and Animals

D.  Animals Living in Crowded Cities
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✓

Q52 English
Where was Jhumri first seen again after her disappearance?

A.  Kanha Tiger Reserve in Madhya Pradesh

B.  Bandhavgarh Tiger Reserve in Madhya Pradesh

C.  Sundarbans Tiger Reserve in West Bengal

D.  Achanakmar Tiger Reserve in Chhattisgarh

✓

Q53 English
What does the word “corridor” refer to in the passage?

A.  Road used by vehicles only

B.  Building inside forest reserves

C.  Path that connects forest areas

D.  Fence around wildlife parks

✓

Q54 English
Which idea is highlighted throughout the passage?

A.  Tigers prefer living near human areas

B.  Wildlife survival depends on connected habitats

C.  Forests are not needed for animals

D.  Animals do not migrate between places

✓

Q55 English
What can be inferred about tiger movement from the passage?

A.  Tigers move to find new territory and resources

B.  Tigers stay in the same area always

C.  Tigers move only during the winter season

D.  Tigers avoid crossing forest regions

✓

Q56 English
The parts of a sentence are given below. While the first part (S) is fixed and correctly placed, the remaining segments are jumbled. Rearrange
them to form a clear, meaningful, and grammatically correct sentence.

S. Ancient Egyptian society
A. the Nile River
B. for transportation and
C. depended heavily on
D. religious practices

A.  DCAB

B.  BADC

C.  CABD

D.  ADCB
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✓

Q57 English
Select the option that can be used as a one-word substitute for the given group of words.

A place where books are kept

A.  Auditorium

B.  Library

C.  Museum

D.  Laboratory

✓

Q58 English
Select the most appropriate option to fill in the blank.

Harish _____ an apple every morning.

A.  take

B.  eating

C.  eats

D.  eat

✓

Q59 English
Select the sentence that is in the correct form of the past tense.

A.  Rajesh finded an old diary in the attic and spent the whole afternoon reading its faded pages.

B.  Meera and Anjali had prepares a surprise dinner for their parents last weekend.

C.  Nikita sold her new house because she needed money.

D.  Tom and his dog Max was explored the abandoned house on the hill and discovered a hidden treasure.

✓

Q60 English
Select the most appropriate option to fill in the blank.

The machine operated ______ despite the harsh weather conditions.

A.  occasionally

B.  efficiently

C.  temporarily

D.  lazily
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଚନ୍ଦ୍ର ପୃ ଥି ବୀର ଉପଗ୍ର ହ ଅଟେ ।

A.  The Moon is the satellite of Earth.

B.  Moon are a satellite of Earth.

C.  The Moon be satellite on Earth.

D.  Moon is satellites of the Earths.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ବଜାରରୁ  ତଟକା ପନି ପରି ବା ଆଣି ଥି ଲେ ।

A.  He bought fresh vegetables from the market.

B.  He buy fresh vegetable on market.

C.  He was bought vegetables from markets.

D.  He buyed fresh vegetables in the market.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
କୃ ତ୍ରି  ମ ବୁ ଦ୍ଧି ମତା ସଫ୍ଟ ୱାର ସ୍ୱତଃ ଭି ନ୍ନ ଛବି ଗୁ ଡି କକୁ  ପରସ୍ପରଠୁ  ଭି ନ୍ନ ବି ଚାର କରି ବାରେ ସାହାଯ୍ୟ କରି ପାରେ ।

A.  AI software can automatically detect which images are different from each other accurately.

B.  AI software can automatic detect which images are different from each others accurate.

C.  AI software can automatically detects which image are different from each other accurately.

D.  AI software can automatically detect which images is different from each other accurate.
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✓

Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ ।

“ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତା" ଶବ୍ଦଟି  ସି ନ୍ଧୁ  ନଦୀର ନାମରୁ  ଆସି ଛି , ଏହା ଦକ୍ଷି ଣ ଏସି ଆର ପ୍ର ମୁ ଖ ନଦୀଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଗୋଟି ଏ ଯାହା ବର୍ତ୍ତ ମାନର ପାକି ସ୍ତାନ ଏବଂ ଉତ୍ତର-ପଶ୍ଚି ମ ଭାରତ ଦେଇ ପ୍ର ବାହି ତ
ହୁ ଏ। ଏହି  ନାମ ଏହାର ଭୌଗୋଳି କ ସ୍ଥଳବି ଶେଷ ଏବଂ ସି ନ୍ଧୁ  ନଦୀ ଅବବାହି କାରେ ହୋଇଥି ବା ପ୍ର ତ୍ନତାତ୍ତ୍ୱି କ ଆବି ଷ୍କାର ଉଭୟକୁ  ପ୍ର ତି ଫଳି ତ କରେ।

"ସି ନ୍ଧୁ " ଶବ୍ଦର ଏକ ପ୍ରା ଚୀନ ଭାଷାଗତ ଇତି ହାସ ଅଛି । ଏହା ପୁ ରୁ ଣା ପାରସ୍ୟ ଶବ୍ଦ "Hinduš" କୁ  ଫେରି ଯାଏ, ଯାହା ସି ନ୍ଧୁ  ନଦୀ ଚାରି ପାଖର ଭୂ ମି କୁ  ବୁ ଝାଏ। ପାରସ୍ୟ ଲୋକମାନେ ଏହି  ଶବ୍ଦକୁ  ସଂସ୍କୃତ
ଶବ୍ଦ "ସି ନ୍ଧୁ  " ରୁ  ଗ୍ର ହଣ କରି ଥି ଲେ, ଯାହାର ଅର୍ଥ  "ନଦୀ" କି ମ୍ବା ବି ଶେଷ ଭାବରେ "ସି ନ୍ଧୁ  ନଦୀ"। ଭାରତୀୟ ଉପମହାଦେଶର ସବୁ ଠାରୁ  ପୁ ରୁ ଣା ଗ୍ର ନ୍ଥ ମଧ୍ୟରୁ  ଗୋଟି ଏ, ଋଗ ବେଦରେ, ସି ନ୍ଧୁ  କେବଳ
ନଦୀ ନୁ ହେଁ  ବରଂ ଏହାର ଚାରି ପାଖର ଅଞ୍ଚଳକୁ  ମଧ୍ୟ ବର୍ଣ୍ଣ ନା କରି ବାକୁ  ବାରମ୍ବାର ଦେଖାଯାଏ । ଯେତେବେଳେ ପାରସ୍ୟମାନେ ସି ନ୍ଧୁ  ନଦୀର ସମ୍ମୁଖୀନ ହେଲେ, ସି ନ୍ଧୁ ରେ ପ୍ରା ରମ୍ଭି କ "s" ଶବ୍ଦକୁ  "h"
ଭାବରେ ଉଚ୍ଚାରଣ କରାଯାଇଥି ଲା ।

“ସି ନ୍ଧୁ " ନାମଟି  ଲାଟି ନ ଭାଷା ମାଧ୍ୟମରେ ଇଂରାଜୀରେ ଆସି ଛି  | ଏଥି ରୁ  ଇଂରାଜୀ ଶବ୍ଦ "ଇଣ୍ଡି ଆ" ବି କଶି ତ ହୋଇଥି ଲା, ଯାହା ମୂ ଳତଃ ସି ନ୍ଧୁ  ନଦୀ ସେପାରି ରେ ଥି ବା ଭୂ ମି କୁ  ବୁ ଝାଉଥି ଲା। ତେଣୁ ,
ସଭ୍ୟତାର ନାମ - ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତା - ଆଧୁ ନି କ ଇଂରାଜୀରେ ପ୍ର ବେଶ କରି ବା ପୂ ର୍ବ ରୁ  ସଂସ୍କୃତ, ପାରସ୍ୟ, ଗ୍ରୀ କ୍  ଏବଂ ଲାଟି ନ୍  ଦେଇ ଗତି  କରି ଥି ବା ଏକ ଭାଷାଗତ ଶୃ ଙ୍ଖଳକୁ  ପ୍ର ତି ଫଳି ତ କରେ।

ଏହି  ସଭ୍ୟତା ଅନ୍ୟ ଏକ ଶବ୍ଦ ହରପ୍ପା ସଭ୍ୟତା ଦ୍ୱାରା ମଧ୍ୟ ବେଶ ପରି ଚି ତ , ଯାହା ହରପ୍ପାଙ୍କ ନାମ ଅନୁ ସାରେ ନାମି ତ ହୋଇଛି । "ହରପ୍ପା" ନି ଜେ ସ୍ଥାନୀୟ ଗ୍ରା ମର ଆଧୁ ନି କ ନାମରୁ  ଆସି ଛି , ପ୍ରା ଚୀନ
ଏବଂ ଆଧୁ ନି କ ଭୂ ଗୋଳ ମଧ୍ୟରେ ଏକ ନି ରନ୍ତରତା ରଖି ଛି  ।

ତେଣୁ , "ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତା" ଶବ୍ଦର ବ୍ୟୁ ତ୍ପତ୍ତି  ସି ନ୍ଧୁ  କ୍ଷେତ୍ର  ସହି ତ ଜଡି ତ ନାମଗୁ ଡ଼ି କର ଦୀର୍ଘ  ଐତି ହାସି କ ଏବଂ ଭାଷାଗତ ବି ବର୍ତ୍ତ ନକୁ  ପ୍ର କାଶ କରି ଥାଏ । ଏହା ଆଲୋକି ତ କରେ ଯେ ସାଂସ୍କୃତି କ
ସମ୍ପର୍କ  ଏବଂ ବି ଜୟ ଆଜି  ଆମେ ବ୍ୟବହାର କରୁ ଥି ବା ଶବ୍ଦକୁ  କି ପରି  ଆକାର ଦେଇଥି ଲା। ସି ନ୍ଧୁ ରୁ  ସି ନ୍ଧୁ  ପର୍ଯ୍ୟ ନ୍ତ, ଏହି  ନାମଟି  ମାନବଜାତି ର ପ୍ରା ରମ୍ଭି କ ସଭ୍ୟତା ମଧ୍ୟରୁ  ଗୋଟି ଏକୁ  ବଜାୟ ରଖି ଥି ବା
ଭୌତି କ ନଦୀ ଏବଂ ପ୍ରା ଚୀନ ଭାରତକୁ  ବ୍ୟାପକ ବି ଶ୍ୱରେ ପରି ଚି ତ କରାଇବାର ଭାଷାଗତ ଯାତ୍ରା  ଉଭୟକୁ  ମୂ ର୍ତ୍ତିମନ୍ତ କରେ।

ସଂସ୍କୃତରେ ସି ନ୍ଧୁ  ଶବ୍ଦର ଅର୍ଥ  ହେଉଛି :

A.  ପର୍ବ ତ

B.  ନଦୀ

C.  ସଭ୍ୟତା

D.  ଭୂ ମି

✓

Q65 Odia
"ସି ନ୍ଧୁ " ନାମଟି  କେଉଁ  ଭାଷା ମାଧ୍ୟମରେ ଇଂରାଜୀରେ ଆସି ଛି ?

A.  ଗ୍ରୀ କ୍

B.  ପାର୍ସୀ

C.  ଲାଟି ନ୍

D.  ଆରବି

✓

Q66 Odia
ସି ନ୍ଧୁ ର ପାରସି କ ରୂ ପ କଣ ଥି ଲା:

A.  ହି ନ୍ଦୁ

B.  ଇଣ୍ଡୋସ୍

C.  ଭାରତ

D.  ସପ୍ତ ସି ନ୍ଧୁ

✓

Q67 Odia
"ହରପ୍ପା ସଭ୍ୟତା" ଶବ୍ଦଟି  କେଉଁ  ଉପରେ ଆଧାରି ତ:

A.  ସି ନ୍ଧୁ  ନଦୀ

B.  ସ୍ଥାନୀୟ ଗ୍ରା ମର ଆଧୁ ନି କ ନାମରୁ

C.  ଜଣେ ପ୍ରା ଚୀନ ରାଜାଙ୍କ ନାମ

D.  ଋଗ ବେଦି କ ଗ୍ର ନ୍ଥଗୁ ଡ଼ି କ
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✓

Q68 Odia
ଉପରୋକ୍ତ ଗଦ୍ୟାଂଶ ପାଇଁ  ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ଶୀର୍ଷ କମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ଶୀର୍ଷ କ ଚି ହ୍ନଟ କର।

A.  ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତାର ବି କାଶ

B.  ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତାର ଭାଷାବି ଜ୍ଞାନ

C.  ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତାର ଇତି ହାସ

D.  "ସି ନ୍ଧୁ  ଉପତ୍ୟକା ସଭ୍ୟତା" ଶବ୍ଦର ବ୍ୟୁ ତ୍ପତ୍ତି

✓

Q69 Odia
ମାତୃ ଭୂ ମି  ସରଗଠାରୁ  ଗରୀୟାନ । ଏହି  ବାକ୍ୟରେ "ଗରୀୟାନ" ଶଦ୍ଦଟି  କେଉଁ  ପ୍ର କାରର ବି ଶେଷଣ ?

A.  ବି ଶେଷଣର ବି ଶେଷଣ

B.  ତୁ ଳନାତ୍ମକ ବି ଶେଷଣ

C.  ସାର୍ବ ନାମି କ ବି ଶେଷଣ

D.  ବି ଧେୟ ବି ଶେଷଣ

✓

Q70 Odia
"ଠଅ ବୁ ଲି ଯି ବା"-ଏହି  ରୁ ଢି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ଗୋଲ ବୁ ଲି ଯି ବା

B.  କି ଛି  ଆରମ୍ଭ ହେବା

C.  ସବୁ  ଶେଷ ହୋଇଯି ବା

D.  ଅଧି କ ଲାଭ ହେବା

✓

Q71 Odia
"କାନ୍ଧ ଲଗେଇବା"-ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  ଝଗଡା କରି ବା

B.  ସାହାଯ୍ୟ କରି ବା

C.  ରାଗ କରି ବା

D.  ପାଖରେ ରହି ବା

✓

Q72 Odia
ତୁ  ଯେତେ ମାଠି ବୁ  ମାଠ, ମୁଁ  ସେହି  ଦରପୋଡ଼ା କାଠ । ଏଥି ରେ ଥି ବା ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର |

A.  ଯେତେ

B.  ମାଠି ବୁ

C.  ମୁଁ

D.  ଦରପୋଡ଼ା
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✓

Q73 Odia
ଜଣେ 'ସଜ୍ଜନ' ବ୍ୟକ୍ତି  ସବୁ ବେଳେ ________ ର ସାଙ୍ଗ ଛାଡ଼ି ବା ଉଚି ତ୍ ।
(ନି ମ୍ନ ରେ ପ୍ର ଦତ୍ତ ଶବ୍ଦ ମଧ୍ୟରୁ  ସଠି କ ଶବ୍ଦ ବ୍ୟବହାର କରି  ଶୂ ନ୍ୟସ୍ଥାନ ପୂ ରଣ କର)

A.  ଖରାପ

B.  ଦୁ ର୍ଜ ନ

C.  ମନ୍ଦ

D.  ଅଧମ

✓

Q74 Odia
ମାଳବି କା ମାଛ କାଟୁ ଛି  । ଏହି  ବାକ୍ୟରେ 'କାଟୁ ଛି ' କେଉଁ  ପ୍ର କରାର କ୍ରି  ୟା ?

A.  ଅକର୍ମ କ କ୍ରି  ୟା

B.  ଦ୍ଵି କର୍ମ କ କ୍ରି  ୟା

C.  ସକର୍ମ କ କ୍ରି  ୟା

D.  ନାମଧାତୁ  କ୍ରି  ୟା

✓

Q75 Odia
"ଜି ରାରୁ  ଶି ରା କାଢି ବା"- ଏହି  ରୂ ଢି ର ଠି କ୍  ଅର୍ଥ  କ'ଣ ?

A.  ଛୋଟ କଥାକୁ  ଗୁ ରୁ ତ୍ଵ ଦେବା

B.  ଅଯଥା ଦୋଷ ଦେଖାଇବା

C.  ନୂ ତନ କଥା ଶି ଖି ବା

D.  ସତ୍ୟ କଥା କହି ବା

Computer

✓

Q76 Computer
Which of the following statements about the Inbox and Outbox in
an email system is correct?

A.  The Inbox stores emails that have been sent.

B.  The Outbox permanently stores all the sent emails.

C.  The Inbox holds received emails, while the Outbox stores
emails waiting to be sent.

D.  The Outbox contains spam emails.

✓

Q77 Computer
What is the short cut in Microsoft Word 2021 that opens 'Reveal
Formatting pane' which allows you to see the formatting applied to
a specific piece of text?

A.  Shift + F1

B.  Shift + F2

C.  Shift + F5

D.  Shift + F9

✓

Q78 Computer
Which is the following is an application software?

A.  Macintosh

B.  Android

C.  Fedora

D.  iTunes

✓

Q79 Computer
In a multilevel list, which key is typically used to indent a sub-item
under a main bullet point?

A.  Shift

B.  Ctrl

C.  Tab

D.  Alt
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✓

Q80 Computer
Why is power saving mode used in Microsoft Windows 11?

A.  To play games faster

B.  To increase the system performance

C.  To increase the number of tasks running

D.  To reduce energy consumption

✓

Q81 Computer
What is slide transition in MS PowerPoint?

A.  A printing option for handouts

B.  A method of inserting images into slides

C.  A feature that animates text within a slide

D.  An effect applied when moving from one slide to another

✓

Q82 Computer
What happens when you use "Save" (Ctrl+S) for the first time in a
new document?

A.  The document closes automatically

B.  The "Save As" dialog box opens to name and choose a
location

C.  The document prints immediately

D.  All formatting is removed

✓

Q83 Computer
The speed at which a CPU operates is measured in _______.

A.  Hertz (Hz)

B.  milliseconds (ms)

C.  nanoseconds (ns)

D.  picoseconds (ps)

✓

Q84 Computer
What happens when you apply a template to an existing MS
PowerPoint presentation?

A.  It completely replaces all slides and content.

B.  It only changes the background without affecting text
formatting.

C.  It applies a new design while keeping existing slide content.

D.  It converts the PowerPoint into a read-only format.

✓

Q85 Computer
Which of the following is an input device used to enter text into a
computer?

A.  Keyboard

B.  Monitor

C.  Printer

D.  Speaker

✓

Q86 Computer
Which of the following menu options can be used to start a slide
show in PowerPoint?

A.  Insert → Start Show

B.  Slide Show → View Show

C.  File → Start Presentation

D.  Tools → Begin Show

✓

Q87 Computer
In MS Excel 2010, what happens if you sort only one column in a
table without expanding the selection?

A.  Only the column is sorted, other data stays intact.

B.  All rows are deleted.

C.  Data becomes misaligned.

D.  All rows are locked.

✓

Q88 Computer
In MS Excel 2010, which of the following key combinations inserts a
new row above the currently selected row?

A.  Ctrl + Shift + R

B.  Ctrl + "+"

C.  Alt + I + R

D.  Shift + Enter
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✓

Q89 Computer
Which of the following is an example of an Internet service?

A.  MS Word

B.  Email

C.  Notepad

D.  Calculator

✓

Q90 Computer
When using a custom number format within the TEXT function in MS
Excel, which elements should be excluded from the format code?

A.  Date formatting elements

B.  Semicolon (;) and the '@' character

C.  Commas and spacing characters

D.  All numeric digits used in the format

Reasoning

✓

Q91 Reasoning
In a certain code language, ‘OPEN’ is coded as ‘7542’ and ‘EARS’ is
coded as ‘1356’.
What is the code for ‘E’ in the given code language?

A.  5

B.  1

C.  3

D.  4

✓

Q92 Reasoning
CION is related to QWCB in a certain way based on the English
alphabetical order. In the same way, GMSR is related to UAGF. To
which of the following options is WCIH related, following the same
logic?

A.  KQWV

B.  KQVW

C.  KRTY

D.  KSWE

✓

Q93 Reasoning
What should come in place of '?' in the given series based on the
English alphabetical order to make it logically complete?
NER LCV JAZ HYD ?

A.  EWG

B.  FVI

C.  GXH

D.  FWH

✓

Q94 Reasoning
G, H, I, J, K and L live on six different floors of the same building. The
lowermost floor in the building is numbered 1, the floor above it,
number 2 and so on till the topmost floor is numbered 6. L lives on
floor which is a prime number. The product of floors on which L and
G live is 3. Only two people live above I. H lives immediately below J.
How many people live above K?

A.  1

B.  2

C.  3

D.  4

✓

Q95 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 723168, how many digits will appear more than
once in the new number thus formed?

A.  None

B.  One

C.  Two

D.  Three
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✓

Q96 Reasoning
A, B, C, D, J, K and L are sitting around a circular table facing the
centre of the table.
Only two people sit between L and K when counted from the right of
L. Only two people sit between K and D. Only three people sit
between L and A. C sits to the immediate left of B.
Who sits third to the left of J?

A.  A

B.  B

C.  D

D.  L

✓

Q97 Reasoning
In a certain code language,
A @ B means ‘A is the father of B’
A & B means ‘A is the wife of B’
A # B means ‘A is the husband of B’
A % B means ‘A is the daughter of B’

Based on the above, how is P related to T if ‘P # Q % R & S @ T’?

A.  Wife’s father

B.  Father’s father

C.  Sister’s husband

D.  Father’s brother

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All Reds are Blues. All Blues are Greens.
Conclusion I: All Greens are Reds.
Conclusion II: Some Greens are Reds.3961

A.  Only conclusion (I) follows

B.  Only conclusion (II) follows

C.  Neither conclusion (I) nor (II) follows

D.  Both conclusions (I) and (II) follow

✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
letter cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)2843

A.  LM−HL

B.  HI−EF

C.  PQ−MN

D.  UV−RS

✓

Q100 Reasoning
Refer to the following letter series and answer the question that
follows.

(Left) P O I U Y T R E W Q L K J H G F D S A Z (Right)

How many letters are there in the English alphabetical order
between the letter which is fourth from the right end and third from
the left end of the series? 5522

A.  Five

B.  Three

C.  Six

D.  Four
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